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1. >Uvbeon oto cm.harica.gr
Juvdeopaote otnv oehida https://cm.harica.gr kot emAéyoupe I6pupatikéd Login/Academic Login.
Mavw 6&€Ld prmopoupe va aAAGfou e TV YAWooo TG oeAidac.

FHARICA NIcR

Eloodog

Atv ExeTe Aoyapraopd; Mvet

Higxktpovixd raxudpopelo

Kwdikég

Em\éyoupe wg dopéa to Alebvég Navemiothpio tng EAAGSo¢ kat matdue EmBeBaiwon/Confirm.

GRNET AAI EmAOYR OIKeiou Qopéa ®opeic YTinpeoieg Tekpnpiwon BoiBsia EAANVIKG English
) OpooTrovdia EAYTE
%l DELOS
YTtodopr Tautotroinong kai E§ouaiodotnong (AAl)

BpiokeoTe o€ auTAv TN OeAida eTTEIBN TTPOCTIABNOATE VA TIPOOTTEAACETE UG UTTNPECIT TTOU CUPPETEXEI OTNV OpooTTovdia AHAOZ Tou EAYTE. MpoKeIgévou va TTPOXWPIOETE, Ba
TIpéTrel va emAELETE ToV OIKeio Dopéa oag aTrd Tov TTapakdTw KAaTdAoyo. MPOAIPETIKA, PTTOPEITE va aTTOBNKEUOETE TNV ETNAOYH AUTH, WOTE VO PNV EPWTNOEITE O€ ETTOPEVEG CUVDEDEIG

oag,
‘ AigBvég NavemoTtnpio Tng EAAGSOG v \ EmBepaiwon

ATToBRKeuon TG TpoTipnong: [

Autopata Ba petadepBolpe og véa oeida émou Ba TPETMEL Vo TANKTPOAOYHCOULE TO OVOUQL
Xpriotn/username kat tov KwSiko/password Tou LopupaTiKoL pag Aoyaplacpol Kal
natape 20véeon.

AL AIEONES
TTANEMIZTHMIO
THZ EAAAAOS

& Ovopa xprioTn

8 Kwdikog ®

=Zexdoare Tov KwdIKG 0ag;


https://cm.harica.gr/

2.

Altnon yla Mponyuevn HAektpovikr Yroypadn

ErtiAéyoupe amo to pevol ota aplotepd HAekTpovikég YioypadEc.

= WMHARICA

B Dashboard

B eSign Eyypaguwy

MotonouTikda

B HAextpovikés Ynoypapés

@ HAextpovikég Zppayideg

8 Notonomuxa Server

ErttAoyn tumou MiotomotnTikou

Ertidéyoupe MNponypévn HAektpovikn Yrioypadn > MNa emelpRoeLs f opyavicpoug (IV+OV) kat
TaTdpe oto koupni EmtAoyn.

Mponyuévn Hiektpovikn Ymoypagpn

MNa wuwwteg 1 atopukég enxelpnoeig (1V)
Mutomomtko Mponyuévng HiexTpovikn g YIoypapne yua umoypagn .
vvoaowy.Me Ve Emihoyn
ey ypapv. MepthapBaveL:
¢ Tol MPOTWIMIKG O0g OTOKE

' A

ano

50€ étocg

MNa emyepnoelg N opyavicuouc (IV+OV)

MotomomTkd MNponyuévng HAektpoviknc Ymoypaprc yia umoypagpr

eyypapuwy. MephapBaver Ertidoyn)
o Tl MPOTWITIKG TOg OTOIKELD
* Ta oToEln Tou opyaviolol LLE TOV ONoio £XETE EVEDYT]
OUVEDYQLOLO

Awpeav



MOALG BeBatwBolpe ot EmAEXONnKe motape Emopevo.

Ma emyepnoelg N opyaviouolg (IV+OV)

Motomommkod Mponypsvng Hisxtpovikneg YIoypapne yio unoypadgn

eyypapuwy.NephapBaver: ( EmAgyBnke )
* Ta MpOCWIIKGA OO OTOLKELD
* T OTOWKELD TOU OPYOVITLLOU LLE TOV OTTOLD £XETE EVEDYN Aw pE{'l‘u'
gUVEpYOOIa

4. Emloyn kot petadoptwon eyypadwyv tTautonotnonc
2Ta OTOLXELO TOU TILOTOTIOLNTLKOU TIOU TIPOKELTAL VA eKS0OEL, EKTOC ATIO TO OVOUATENMWVUUO LOG,
XPELATETOL VO UTTAPXEL KOL EVOL ETILITAEOV HOVASIKO XOPAKTNPLOTIKO.

e EmAéyovtag tnv TUTIKA nepintwon, n HARICA Ba mapdyel autopata, éva povadiko
10y Lo avayvwploTiko To omolo Ba sloayBel ota otolyela Tou mIoTOMOLNTIKOU pag. To
Lovo Tou Ba xpelaotel, gival va emidé€oupe avapeoa oto AgAtio Tavtotntag (AAT) ) to
AlaBoatrplo kot To omnoio Ba petapopTWOOUHE WE SLKOLOAOYNTLKO.

@ EmAé€re Tov TUmno efakpifwong tavtémmrag mov Ba
XPTOUOTIOINOETE

I A. Tumn nepinrwon (npoteiveray) I <

URTEPIAGP
atnpiou/AQM

OLOV £L51KO AOYO

JPLOTIKG QUTIKOD

) (Ap. Tautoty NTIKS Hou.

Xwpa SIKAOAOYNTIKWV

Tomog Eyypagou

ApiBuOG AzATiou TawTOTNTOG (AAT) v

E TE TUMO EYYPAPOU
ApBuoe Asiriou Tautomrag (AAT)
ApBuog Aapatmplou

R Siwlsm meninrmem aa

@ AveBaote Ta £yypaga tavtonoinong

* EmiAoyn apxziov )

e Je MePIMTWon Mo MBUMOUE TO TILOTOTOLNTLKO MOG VA €XEL €va OTABEPO OVAYVWPLOTLKO, TO
omoio Ba dnuoactevetat pall pe tnv urtoypadn pag, LmopoUpe va emiAéEoupe Tn cUVOETN
nepintwon Kot oto £i60¢ oTabepol avayvwpLoTKoU GUOLKOU TIPOCWTTIOU EXOULE TLG
eTAoyEg Ttou Agltiov Tavtotntag (AAT), AtaBatnpiov kat @opoAoyikol Mntpwou (ADM).
Mo kaBe pa amno tig Stabéatpeg emhoyEg, Oa xpelaotel va MANKTPOAOYCOULE TOV aplBuo
otaBepol avayvwploTtkoL Ti.X. AA123456 yia AAT Kot val LeTAdOPTWOOULE TO AVTLOTOLXO
SwatohoynTiko.



©é\w va poobéicw éva aTaBepd avVayVWpLOTIKG (PUOIKOU TpoouTtou (Ap.
Tavtémrag/Mapatnplou/AQM) ato MIOTOMOMTIKG LoU.

Eni\éEre TOMO eyypagou

ApiBLog AzhTiou TauTéTNTOC (AAT) v

Emm\éETe £lbog oTabepol avayvwpLOTIKOU (PUCLKOU TTPOCLITIOU

Ap186¢ Aedtiov Tavtdmrag (AAT)
ApBudg Aapatnplou
ApiBuoc Qoporoyikol Mntpwou (AQM)

Greece v

ApiBude Eyypagou

TUPTIANPLWOTE TOV aptBUO Eyypaoou

C. Zovéeom elDAS a

v

To MOoTOROMTIKG pou Ba EPLEXEL TTANpO@Ooplieg mou napéyovrat and v EBvikn

Ympeoia EfaxpiBweng Tautémrag Mg xweag pou (elD).

@ AveBaote ta éyypaga tavtonoinong

Emidoyn apxeiov



MNPOZOXH! Itnv e161kN Mepimtwon mou emilé€oupie Tov AptOpuo Mopoloyikol Mntpwou (ADM),
£KTOG arto tov apldud otabepol avayvwplotikol mou Ba Anktpoloyrooupe (9Pridio AOM), Ba
Xpelaotel va eTNéEou e Eva eTUITAEOV SIKOLOAOYNTLKO WG EMIONUO €yypado TAUTOMOLNONG KAl TO
orolo Ba peTadopTWOoOULE.

B. Z0vBemn neplrrwon (

©é\w va npocBicw Eva oTaBepPd aVayVWPLOTIKG PUOIKOU TTPOCwITou (Ap.
Tavtémrac/Aapampiou/AQM) oTo MOTOMONTIKG HOU.

Emégre TOmo eyypagou

ApiBLOC PopoAoyikoy MnTpuwou (ADM) v

Xwpa SIKALOACYNTIKWY

Greece v

Ap1Budg Eyypagou

TULTTANPWOTE TOV 0plBuo eyypagoy

E@doov enhétate Tov ApiBud Qopoloyikou MnTpwou, mapakaloOpe emAEETE Kal
£va emionpo Eyypa®o TaUTONPoswWnlac.

Tomog Eyypagou

ApiBpoc AzATiou TauTOTNTOG (AAT) W

Em\éETe TOmo eyypagou
Ap18u6c Askriou Tautomrag (AAT)
ApiBuog Mapatnplou

@ AveBaote ta éyypaga tavtonoinong

q Emidoyn apxeiov )

IKavApETE Kal avePAoTe To AgATlo TautoTNTAg cag (2 GWELC)

Mropelte va aveBACETE TO Eyypawod oag ot éva elTe neplocdTepa apyela. Ot EmTPeENOpEVOL
Tunot apyelwv elval .pdf, jpeg. .png. .zip. To néyedog Twv apyelwv Sev npénel va uneppalvel Ta
2MB

Avepaorte to éyypagpo Api8uol Qopoloyikot Mntpuwou oag

q Emdoyn apxziov )




JTN GUVEXELQ KAVOUUE EAEYXO OV TO OVOUOTEMWVU O Hag Talpldlel amdAUT LE TO MO0
£yypado TauTonoinong mou €XoUpEe LETAdOPTWOEL KOL KAVOUE TLG amapaitntes Slopbwoelc.
MPOALPETIKA, UTTOPOULE VA ELOAYOUE TO OVOLATEMWVUHO HAG KOL OE XOPAKTHPEC TNG TOTIKAG LOG
YAwooag cludwva Tavta e To enionpo yypado tavtonoinong. Enetta, emhéyoupue Emopevo.

@ EmBepawwote 611 Ta npoownika oag otowxela elvat owota
CUITANPWHEVA

wWvuRo) elvat GWoTA KAl avTIoToNoUV andAuta

po éyypago efakplfwong TauTéTNTAg oV

‘Ovopa (ue AativikoUg xapaxmpeg) EniBeto (ue AaTvikoUg XapakThpeg)

O&é\w va ElTdyw To Ovoud Katl To emiBeTd

' 295 |
..7,1 ArtoBéxopat 6T

YPURPa) HE auTa GTO ENIONHO EYYPaPO EXa

avTigToLouy anéiuta \YPGyL
plpwong

TQUTOTNTAC.

< Mponyoluzvo Enopevo

Erttloyn opyaviopou

ErmtiAéyoupe av emBUUOUUE va epudavileETal OTO MLOTOMOLNTLKO HOG, TIEPAV TOU OPYQAVIGUOU LOC
(International Hellenic University), To tuiua (OpyavwTtiky Movada) 6To 0moio avKouue Kot
nataue Emopevo.

EmiAé€te TOoV Oopyavicpo cag
@ International Hellenic University
2TolXeia Tou opyavicpou

Nopyn enwvupia

International Hellenic University - IT Center

Nopwn enwvupia (Torukn Nwooa)
Aebvég MNavermomypo mg ENadog

Xwpa
GR

MoéAn

Thessaloniki

MoAn (Torukn MNwooa)

Oegoahovikn



Ertidoyn puebodou tavtonoinong

Ma tnv pébodo tautomoinong, Exoupe SUO EMAOYEG YLO TLG OTIOLEC KOAOUBOUIE TIG QVTIOTOLXEG
odnylec.

MNPOZOXH! Ta éyypada mou Ba petadoptwooupe otn HEBOSO TAUTOTIOLNCNG TIPEMEL VA ElvalL OF
Hopon .pdf

A. Emukowwvia pe tnv e§unnpétnon xpnotwv HARICA.

@ Ern\é€re pla and g napakdtw pedddoug ekakpiBwong
TautéTag

A. ©a Beha va emxovwvnoeL 1} kurmpétmon xpnotwv mg HARICA (
padi pou (anatrsital Quokn napouaoia)

H efurmpemon xpnotwy Ba enkotvwviioel pall oag oyeTikd pe ) dadikaoia
efakplBwong Tautdmrac.

B. ©®a xpnowonomow pa unapyouvoa Eykekpiuévn HAektpovikn v
Ynoypaen

H emukowvwvia pe tnv e€unnpétnon xpnotwv tng HARICA mpolmoB£tel Tn duacLkr oo mopoucia yla
TNV TOUTOMOoLNoN HE Kia ot TLG TP AKATW ETUAOYEG:

1. Quown napouoia oto Tunpa NAnpodopikng (Kévtpo Alaxeipiong Alktiou) Tng
MavemotnUlouToAewe oag, Loll pe enionpo éyypado TOUTOMPOowTtiag (AoTUVOULKNA
Tavutotnta f dtapatrplo) i

2. Extunwon YmeuBuvng AfAwong, cUUMANpwon Kat erikatporntoinon o KEM r; dAAn
dnuoocta apxn (OXI amd gov.gr) yia to yvrolo tng umoypadnc.



https://tinyurl.com/52cwmnpn

B. Xpron udlotdpevng EykekpLlpuévng HAektpovikig Yroypadrg (r.x. £§ anootdoswg
nAektpoviki unoypadn 1 mLoTonowntiko EykekpLévng HAekTpovikng Yroypadng oe
KpurttoypadLKr GUCKEUR).

AUTOC O TPOTOG OG SLEUKOAUVEL TIEPLOCOTEPO EPOCOV SLABETOUE EVEPYO TILOTOTIOLNTIKO KABwWG
8¢ Ba amattnBel puoikr mapouoia ylo ThV TUTOMOLNGCT Hag.

MNPOZOXH! Eav tnv mponyoLevn ¢popa Mo KAVOE aitnon XpNOLULOTIONCAE TNV
OUYKeKpLUEVN LEBOSO, autr tn dopa Sev Ba epdaviotel otig Stabeoiueg emhoyEg. Baost
KOVOVLOUWV OITOYOPEVETAL 2 CUVEXOUEVEG GOPEC VAl YIVETOL ATNON XPNOLLOTIOLWVTOC TN
OUYKeKPLUEVN HEB0SO eakpifpwong TautdTnTaC.

B. ©a xpnowonomow pa vnapyouvoa Eykekpiuévn HAektpoviky) <
Ynoypaon

1. KateBaote v aiton Eykekpiuévng Hhektpovikng Yrioypagng
Aitmon Eykekpipévou [Motomomtikot yia HAektpovikn Ymoypapn

2. JUUIANPWOTE TIG ATATOVEVES TTANPOQOPIES

3. Yrnoypalte v aitnom pe v unapyxouvoa HAekTpovikn
Yroypapn

4. AveaOoTe TO UMOYEYPQAUUEVO £YYPAPO

D_1-33 HARICA Qualified Certificate Request for
eSignature cm.harica.gr v1.0 EL.pdf

EmiAoyn apxsiov

EmAéyoupe EmOpevo.

(%]




7. Tpoemniokonnon aitnong
EAéyxoupe Ta otolxeia tng aitnong kot erthéyoupe OtL StaBdoape Kal amodexopacte touc Opoug
Xpnong kot TG Atadikaoieg kat MoAttikn Miotomoinong tng HARICA. Enetta, emthéyoupe EmMopevo.

EAéyEre v altmon npwv v kataBéoete

Tumog MioTomomTisow Aidprela Yrmpeoiag
Advanced eSignature OV 2 £

ITowela Tuvbpopn

- | —

AemTopEpele Opyaviopon

Mdppn emunoplio: Aratethe Lnesersity of Thessaiond
Opyavwrue Mowaba, OU: 1T Ceetes

I'h!ﬂm:" 0. O

Kwpa: (&

YIoonpwTka BEyypaga
EiSocg Eyypapou Apyeia

NTR

Amobowtd fefaiwong ouvepyaciag
LE TOV OpYaVIOUS

Eyypapo Tautomoinomc & o pdf

MéBobog EfaxplPwaong

MiBo&oc Apneia
PhysicalPresence
OfH . (To dvoud oog LE AaTvikohs YapokTApES) Sniwvie dTL Sdpaoa

Kol amoSExoualL, e Ty umofoldr e almong, Toug Opoug Xpfone kol Tig Aadikaoleg kol

“ Mok Motemoinong g HARICA. EmumAZoy, ouvan oTT) ypron KoL amoSt|KEUoT) Twy
MATPOEopLWY auTol Tou amfparog, and Tny HARICA, cdpguva e T Afhuwon
SUoTIKSTITOL AESOpEVLWY


https://repo.harica.gr/documents/SA-ToU_EL.pdf
https://repo.harica.gr/documents/SA-ToU_EL.pdf
https://repo.harica.gr/documents/CPS-EL.pdf

8.

Anuoupyla WOLwTtikou KAeLOLoU kat CSR

‘EXOUE TNV emAoyr] va SnULoupynoou e To apxeio CSR oTo mpoypapo TEPLRYNONAC HaG
XPNOLLOTIOLWVTAC TN SUVOTOTNTA AUTOMATNG dnpLoupyiag. H emloyn Autdpatn Snuoupyia CSR
artattei va erthé€ou e tov TUTo/éyeBog Tou KAELSLOU Kol VoL 0ploOUHE £va KwOLKO TIOU TIPETEL val
Bupopaote KaBwg Ba MpooTATEVEL TO LOLWTLKO KAELSL TOU TLOTOMOLNTLIKOU Hag. MaTtdpe To Koupi
Anpovpyia KAELSLOU Kal KATAOEoN ALTANATOG.

KatdBson armparog

@ T eivar To CSR;

|< AvTtopatn dnpovpyia CSR > 'r| ( AwaoTtz 10 51K6 gug CSR )

Qa &nLOVPYNOETE éva I6LWTIKG KAELSL oTov mhonyo oag Kal Ba yivel autéparn napaywyr Tou CSR.

O AxyopiBuog O MéyeBocg KAeSIO0

RSA (TposTiAeypévo) v ‘ 2048 (mpoemAeypévo) v .

Elodyete éva Kwdiko

o em

Enavalapete Tov KwbIKO

‘ ........ @‘«

Karavow kai anodéyopal 6TL 0 UYKEKPLUEVOS KWwEIKOG eival oTnv andAutn katoxr) pou kat nf HARICA
Bev £xel mpoaBaadn O AUTOV ToV KWSIKO.

MNapalafry WOLwWTKOU KAELOLOU
Kavoupe mapoAofn tou ISLWTIKoU KAELSLOU Kal, 0T CUVEXELD, TIATALE TO Kouuri Emiotpodn otov
Dashboard.

MNPOZOXH! Natwvtag to kouuni NapaAafn, Ba katéBel oto pdakedo AQUPELg (amd mpoemiloyr) Tou
umoAoyLoTh pag éva apxelo pe ovopa privateKey.pem. Oa mpémnel va SLatnpriooupe pe aodpalela
TO MOpanAvw apxeio katl Tov KwdLKo Tou oploae 0To ponyoUpevo Brina kabwg Ba ta
XPNOLLOTIOLOOUE apyOTEPa 0TV SLadIlKaolo LETATPOTG TwV apXELWV .pem ot .pl2.



H aimor gac kataywprBnke eNTuywe

To 1BbLwTikd KRELDL £xEL &npoupynBel kol  mapayyeila Tou MOTOMOWTIKOD TOG
EXEL kaTaywpn Bl

Ba ypewnotel va yiver
‘ - Mopakaf tou WBuwTwod oag Khebol.

MPOXZOXH: Auth eivar i povabikf gopd mou propeite va To mapakaBeTe Kal
Sev Bo umopeite va avaxkmioeTe To 1BwTwd oag kheldl apydrepa.

’ AmoBfiKEuca TO IHUWTIKG Pow kAewbi Emwtpopr oto Dashboard

10. ‘EAeyyxoc aitnong
H aitnon pag, xpelaletal va eykplBei amnd toug umevBuvoug ehéyxou (validators) Tou dopéa pag,
ol onoiot Ba kdvouv Tnv enaAnBeuon Twv oToXelwv He BAon Ta £yypada mou HeTOPOPTWOALLE.

[MoTonomTka og EKKPEROTTITA

Mpoiév Alaprela Minpopopieg Evépyeleg

ov .A\muevo\rml: 1 evépyeia

11. 'Eykplon aitnonc
MoOALg ohokAnpwOei o éAeyxog Ba eldomolnBolpe pe pAvupo NAEKTPOVIKOU Taxudpopeiov, otov
LOPULLATIKO HaG AOYOpLOOHS, YLO VO TIPOXWPICOUE OTNV TTOPAAaBr) TOU TILOTOTIOLNTIKOU HOG.

‘Eykupa rmotonomuka

Mpoiov Aapkela MAnpogopieg

]

ov 2/07/20; C=GR L=ThessalonikiO... [ O

12. MapaAlafn MotomronTtikou
Kavoupe Andn twv apxeiwv PEM kat PEM bundle.



Motornomtiko X

i Aemropépeleg  LARYN  ©OAvakinon A ESomomoel ' Xuvallayn

Mropelte va mapardfete to MoTomomTiKd oag o€ SLAPOPEG LOPPEG, AVAAOYA LE TIG AVAYKES 0ag.

’( PEM > ( DER ) <DERCA> PKCS#7 PEM
(aAvatisda) bundle

Turua) duadikn Torua poper Turukn popen
Toruay popen Turum duadkr Hoppn KEWPEVOL, KEWLEVOD,
KEWEVOU Hopen MotomomTikol oupnepappavet oupnephapBavet
Apxnis Ekdoang OAn mv akuoida O6An Mv aluoida
TUOTOMOMNTIKWY TUOTOMOMNTIKWY

Eav 1o 18uwTtiko KAewdi tou Miotomomtikol oag eival EYKATeECTNHEVO O KPUITTOYPAPIKT) CUOKELT) (token), propeite va mapahaPete ta apyeia DER kat
DER (CA) kat va ta €l0AYeTE 0T CUOKEUT] 0ag LLEOW TOU AOYLOHIKOU Slaxeiplong Tou token. Alagpopetikd, propeite va napakafete ta apyeia PEM kat
PEM bundle, kat padi pe 1o 18uwtikéd KAedl ou dnovpynoate katd m dadikaaia mg aitmong (privateKey.pem), va petafeite ot oghida
https:/www.harica.gr/el/Tools/PemToP12 kat va ta petatpéete o€ éva apyeio .p12, To onoio xpnopornoteital and Stagopa AElToupyikd cuotpata/
EQAPUOYEG.

13. Metatponn apxelwv .pem oe .pl2
Oa mpénel va petaPoupe otnv oeAida https://www.harica.gr/el/Tools/PemToP12, yia va
petatpéPoupe oe popdn .pl2 ta apxeio .pem mou napaldfape poli pe to LSLWTIKO KAELSL
(privateKey.pem) mou £xoupe amoBnkeUoeL TPONYoULEVWE KaTd Th Stadlkaoia tng aitnong.

e EmAéyoupe to apyeio PEM.

MeTaTtpoTtri apXeiwv .pem o€ .pl12

Oa ¥peIaoTETE TO MOTOTIOINTIKO, TO 181ILTIKG KALI1BI kou TNV Apyri Exdoonc.
H Biadikaaia peTaTpoTIrg Twv apyEiwyv TpayPaToTToIEiTal aTToKASIOTIKG aTov TTACNYG oac Kal kavéva oToixgio dev atmooTéAleTal oTnv HARICA

MoTomoinTKS (.pem)

Eriihoyr apyeiou OCPY20 4806 765F438282FCC 91 166C 73AL pem
YN P

e EmAéyoupe To ISLWTIKO KAeLSL (privateKey.pem) mou amoBnkeloope VWPITEPO KOL ELOAYOULE
TOV KWOLKO ToU eiyape oploel yla To LOLWTLKO KAELSL.

1B1WTIKO KA£IDI (.pem)

{ Ertihoyn apyeiou ) privateKey (1).pem

KwdIKOC 181wTIKOU KAEIDIOU

L& TEPITTTWaOn TToU To 181WTIKG oag kA&1di AEN TTpoagTtaTtéuetal pe KwdIkG TTpdoPacng, a@rioTe To TTapammavw Tredio kevo

e Eméyoupe to apyeio PEM bundle.

Apxn ‘Ekdoong (.pem)
{ Emtloyn apxeiov ) DCYZE4BDS765F438282FCCP1166C73A2 (1).pem

MoTotroinTikd Apxr¢ Ekdoong (CA) i PEM bundle


https://www.harica.gr/el/Tools/PemToP12

14.

Opiloupe Tov KWOLKO o Ba MPOCTATEVEL TO TEALKO TILOTOTOLNTLKO OG KOL TIATAUE OTO KOUMTTL
Anpoupyia.

MNPOZOXH! O kwdiKOG MpémeL va €XeL TOUAAXLOTOV 9 XOPOKTIPEG.

OpioTe kWwdIKG apyeiou .p12

Av n Sladikaoia oAokAnpwOnke emtuxwg, Oa katéPel oto pakedo AAYPELS (amo mpoemihoyr)) Tou
UTIOAOYLOTH Hag €va ap)eio pe ovopo HARICA pkcs12.p12.

B HARICA pkes12.p12

Eloaywyn Mwotonotntikou

Ma va ELoAYOUE TO TILOTOTIOLNTIKO Ttou apaAdBape (apxeio HARICA_pkcs12.p12) otov
uTtoAoyLoTH Hag, akoAouBoU e TIC mapakdtw odnylec:

Elcaywyr] TpoowrikoU riotonolntikou ota Windows

Anoapaitntn npolnoBeon eival va €xoupe To apxelo Tou moTonmonTkol He KataAnén pl2, to
orolo mpoékue amo T LETATPOTH TWV apXELWV .pem og .p12 oto ponyoluevo BrApa 13. MNa va
ELOAYOUE TO TILOTOTOLNTIKO Mo ota Windows, kavoupe SUTASG KALK 0TO apxeio Tou
TILOTOTOLNTIKOU Kot tkoAouBoUpe ta Bripata otov odnyo.

EVOAAOKTIKQ, XpnoLlomoloUpe Tov honyo Internet Explorer, 6rmw¢ BAEMOUE MTAPAKATW.

BApa 1: Arto to Baotkd pevou tou Internet Explorer mnyaivoupue Epyaleio/Tools > Emiloyég
Inernet/Internet Options > Neplexdpevo/Content > Miotortowntikd/Certificates.

== X
P~ e 3% €

Print >

File >
Zoom (100%) >
Safety >
Open with Microsoft Edge Ctrl+Shift+E

Add site to Apps

View downloads Ctrl+J

Manage add-ons
F12 Developer Tools
Go to pinned sites

Compatibility View settings

l Internet options l
out Internet Explorer




Internet Options ? X

General Security Privacy Connections Programs Advanced

Certificates
Use certificates for encrypted connections and identification.

" Clear S5L state E Certificates !l Publishers

AutoComplete
= . AutoComplete stores previous entries Settings
== on webpages and suggests matches e
for you.
Feeds and Web Slices
@ Feeds and Web Slices provide updated ‘ Settings
| content from websites that can be - T

read in Internet Explorer and other
programs.

][ ] [
BAua 2: Stnv koptéla Npoowrikd Ztoweia/Personal ataue Etcaywyr)/Import.

Certificates X

Intended purpose: <AH> v

Personal Other People Intermediate Certification Authorities  Trusted Root Cerh’ﬁcaﬁor(‘jﬁ}

Issued To Issued By Expiratio...  Friendly Name

{ Import... 1 Export... ‘- Remove w { Advanced w

Certificate intended purposes

Client Authentication, Secure Email, Document Signing, 1.2.840.113583.1.1.5
‘ View

Brpag 3: Natdpue Endpevo/Next.



2* Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

To continue, dlick Next.

Next Cancel

BApoag 4: Sto sndpevo napdbupo, natdpe Avalftnon/Browse kal avalnTtoUpE TO TPOCWTTKO LG
TILOTOTIOLNTIKO 0TO XWpPo armoBrikevuorg tou. Katomnv natdue Avotypa/Open.

Inueiwon: Av To TILOTOTOLNTLKO pag Sev epdaviletal oto GAakeAO Tou, emhéyoups ‘OAa Ta
apyxeio/All files artd tn Aiota mavw amo to koupri Avolypa/Open yia va To SoUE.

X

& ¥ Certificate Import Wizard

File to Import
Specify the file you want to import.

File name:

Browse...

Note: More than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.P7B)
Microsoft Serialized Certificate Store (.SST)

Next Cancel



& Open X

T ; > ThisPC » Downloads v O O Search Downloads
Organize v New folder == v [H o
o Name Date mcdlf:éd Type Size
# Quick access

I Desktop 2 v Today (1)

& Downloads  # _f,?é haricacert(1).p12 17/12/2021 3:19 pp Personal Informati... 7KB

[ Documents # ~ Last month (5)

[&] Pictures # V| Ypeythini_dilosi_ NDA_GR.docx 26/11/2021 11:38 tp Microsoft Word D... 24 KB
ccare @ Test_PDF_signed.pdf 26/11/2021 11:32 mp Microsoft Edge P... 98 KB
Screenshots @ Test_PDF.pdf 26/11/2021 11:31 mp Microsoft Edge P... 15KB

5 % :ﬁ,\ haricacert.p12 26/11/2021 10:27 mp Personal Informati... 7KB

O8nyoc ékdoon ) i
@ TeamViewer_Setup_x64.exe 22/11/2021 3:40 pp Application 34.037KB

O8nyog moTom
3 This PC
_J 3D Objects % 5
File name: | haricacert(1).p12 v 1 All Files (*.%) v
Open Iv Cancel

BApag 5: Aivoupe tov KwSLKO TIOU TTPOOTATEVEL TO GUYKEKPLUEVO apXelo Kat

eTAEYOU UE ZNpUEiwon TOoU L8LwTIKOoU KAELSL0U w¢ e§aywyipou/Mark the private key as
exportable kat ZupnepiéAaBe 6Aeg tig puBpiceig/Include all extended properties. Enetta
natdpe Endpevo/Next.

€ ¢ Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:

| sesseces

[Jpisplay Password

Import options:

Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option.

wark this key as exportable. This will allow you to back up or transport your
eys at a later time.

Protect private key using virtualized-based security(Non-exportable)

nclude all extended properties.

Next [ Cancel

BApag 6: EmAéyoupe Autopatn emtthoyn Tou riiotonotntikol ¢pakéAov e Baon tov TUIO Tou
rnuotonowntikov/Automatically select the certificate store based on the type of certificate.
Matape Enépevo/Next kat TEAog/Finish.



& 2 Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedify a location for
the certificate.

utomah‘cally select the certificate store based on the type of certificate
(O Place all certificates in the following store

Certificate store:

Personal Browse, .,

Next (Eanc;lw \

& &¥ Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

(el Taek Automatically determined by the wizard
Content PFX

File Name \\ccf2\dfs\winHome \home \tsakirae \Downloads \haricacert(1).]

| Concel

BApag 7: Tédog, Ba epdaviotel éva privupa mou Ba pag mAnpodopel OTL TO TLOTOMOLNTIKO LG
EYKOTAOTAONKE EMITUXWG.

Certificate Import Wizard X

” The import was successful.




Explorer.

BrAuag 8: TéAog, matdpe KAeiowo/Close yia va enotpéPoupe oto napdbupo EmhoyEég
Internet/Internet Options kat OK yia va ertotpéPpoups oto Bactko mapddupo tou Internet

Certificates

X
Intended purpose: <All>

v

Personal Other People  Intermediate Certification Authorities  Trusted Root Certificatior| * | *

Issued To Issued By Expiratio...  Friendly Name
[ Dokimastikos Dokimastikidis HARICA Institutional ...  17/12/2023 <None>
< >
Import... Export... Remove Advanced
Certificate intended purposes
Client Authentication, Secure Email, Document Signing, 1.2.840.113583.1.1.5
View

Internet Options

? X
General

Security Privacy Content  Connections Programs Advanced
Certificates -

Use certificates for encrypted connections and identification.

Clear SSL state Certificates Publishers
AutoComplete

Sil

AutoComplete stores previous entries

Settings
on webpages and suggests matches )
for you.

Feeds and Web Slices

i Feeds and Web Slices provide updated
| ¥=] content from websites that can be

read in Internet Explorer and other
programs.

Settings

OK

Cancel

Apply
Eloaywyr] TPoowrnikov MLoTonownTikol o MacOSX

Kavte SUmAO KALK 0TO apxeio Tou mioTonmontikou Ue KatdAnén pl2, to onoio mpoéku e amo t
METATPOTI TWV apxeiwv .pem o .p12 oto nmponyoupevo Prua 13. MAnktpoAoynote Tov KwdIKO
TPOOTAGCLOC TOU TILOTOMOLNTIKOU.



15.

7N\ Enter the password for “PCertificates.p12™

Password: |

|| Show password

| Cancel__]l ok |

I e e

Av n eLooywyn ATOV EMLTUXAG, TO TILOTOTOLNTLKO oo Ba epdaviletal otn Alota Twv
TLOTOTOLNTIKWY Tou Keychain.

Yroypaodr) pe Adobe Reader

TéAog, umopoupe va cupBouleutol e Tig odnyiec yia xprion tou Adobe Reader yia tnv mpocoBnikn
eykekpévng wnoakng untoypadnig oe apyeia pdf



http://noc.cm.ihu.gr/files/how_to_add_advanced_digital_signature_with_Adobe_Reader.pdf
http://noc.cm.ihu.gr/files/how_to_add_advanced_digital_signature_with_Adobe_Reader.pdf

